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Preface

This section lists various resources that are available for help with using Abaqus Unified FEA software.

Support

Both technical engineering support (for problems with creating a model or performing an analysis) and

systems support (for installation, licensing, and hardware-related problems) for Abaqus are offered through

a network of local support offices. Regional contact information is listed in the front of each Abaqus manual

and is accessible from the Locations page at www.simulia.com.

SIMULIA Online Support System

The SIMULIA Online Support System (SOSS) provides a knowledge database of SIMULIA Answers. The

SIMULIA Answers are solutions to questions that we have had to answer or guidelines on how to use Abaqus,

SIMULIA SLM, Isight, and other SIMULIA products. You can also submit new requests for support in the

SOSS. All support incidents are tracked in the SOSS. If you are contacting us by means outside the SOSS

to discuss an existing support problem and you know the incident number, please mention it so that we can

consult the database to see what the latest action has been.

To use the SOSS, you need to register with the system. Visit the My Support page at www.simulia.com

to register.

Many questions about Abaqus can also be answered by visiting the Products page and the Support
page at www.simulia.com.

Anonymous ftp site

To facilitate data transfer with SIMULIA, an anonymous ftp account is available on the computer

ftp.simulia.com. Login as user anonymous, and type your e-mail address as your password. Contact support

before placing files on the site.

Training

All offices and representatives offer regularly scheduled public training classes. We also provide training

seminars at customer sites. All training classes and seminars include workshops to provide as much

practical experience with Abaqus as possible. For a schedule and descriptions of available classes, see

www.simulia.com or call your local office or representative.

Feedback

We welcome any suggestions for improvements to Abaqus software, the support program, or documentation.

We will ensure that any enhancement requests you make are considered for future releases. If you wish to

make a suggestion about the service or products, refer to www.simulia.com. Complaints should be addressed

by contacting your local office or through www.simulia.com by visiting the Quality Assurance section of

the Support page.
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INTRODUCTION

1. Introduction

This chapter provides an overview of the Abaqus documentation.

The documentation for Abaqus is organized into a collection, with manuals grouped by function (as

shown in Figure 1–1).

Figure 1–1 The Abaqus HTML documentation collection organized according to category.

For information about the manuals available in the Abaqus documentation collection, see “The Abaqus

documentation collection,” Section 1.1.

HTML is the primary format for the Abaqus documentation. The HTML manuals, which contain

all the available content including context-sensitive help pages for Abaqus/CAE, are viewed through a

web browser. Default and advanced searching techniques are available with the HTML documentation.

For more information about the HTML documentation, see Part II, “Using the Abaqus HTML

Documentation.”

Most of the same content, with the exception of the context-sensitive help pages for Abaqus/CAE,

is available in the PDF documentation. The PDF manuals are viewed through a PDF viewer. The PDF

searching capabilities are determined by the PDF viewer used to display the documentation. The PDF

documentation provides a portable reference for Abaqus and offers the ability to obtain high-quality

printed documentation pages. You can print from the HTML documentation; but to print sections that are

larger than a few pages, it is recommended that you print the PDF documentation. For more information

about the PDF documentation, see Part III, “Using the Abaqus PDF documentation.”

1–1
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Note: For information about formats in which each document or publication in the Abaqus collection

is available, see Answer 4013 in the SIMULIA Online Support System, which is accessible from the My
Support page at www.simulia.com.

1.1 The Abaqus documentation collection

The Abaqus manuals are listed and described below.

1.1.1 Abaqus/CAE User’s Manual

This manual includes detailed descriptions of how to use Abaqus/CAE for model generation, analysis,

and results evaluation and visualization. Abaqus/Viewer users should refer to the information on the

Visualization module in this manual.

1.1.2 Abaqus Analysis User’s Manual

This manual contains a complete description of the elements, material models, procedures, input

specifications, etc. It is the basic reference document for Abaqus/Standard, Abaqus/Explicit, and

Abaqus/CFD. Both input file usage and Abaqus/CAE usage information are provided in this manual.

1.1.3 Abaqus Example Problems Manual

This manual contains detailed examples designed to illustrate the approaches and decisions needed

to perform meaningful linear and nonlinear analysis. Many of the examples are worked with several

different element types, mesh densities, and other variations. Typical cases are large motion of an

elastic-plastic pipe hitting a rigid wall; inelastic buckling collapse of a thin-walled elbow; explosive

loading of an elastic, viscoplastic thin ring; consolidation under a footing; buckling of a composite shell

with a hole; and deep drawing of a metal sheet. It is generally useful to look for relevant examples in

this manual and to review them when embarking on a new class of problems.

1.1.4 Abaqus Benchmarks Manual

This manual contains benchmark problems and analyses used to evaluate the performance of Abaqus;

the tests are multiple element tests of simple geometries or simplified versions of real problems. The

NAFEMS benchmark problems are included in this manual.

1–2
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1.1.5 Getting Started with Abaqus: Interactive Edition

This manual is a self-paced tutorial designed to help new users become familiar with using Abaqus/CAE

to create solid, shell, and beam and truss models and Abaqus/Standard or Abaqus/Explicit to perform

static, quasi-static, and dynamic stress analysis simulations. It contains a number of fully worked

examples that provide practical guidelines for performing structural analyses with Abaqus. In addition,

three comprehensive tutorials are provided to introduce users familiar with the Abaqus solver products

to the Abaqus/CAE interface.

1.1.6 Getting Started with Abaqus: Keywords Edition

This manual is designed to help new users become familiar with the Abaqus input file syntax for static and

dynamic stress analysis simulations. The Abaqus keyword interface is used to model examples similar

to those included in Getting Started with Abaqus: Interactive Edition.

1.1.7 Using Abaqus Online Documentation

This manual contains instructions for navigating, viewing, and searching the Abaqus HTML and PDF

documentation.

1.1.8 Abaqus Installation and Licensing Guide

This manual describes how to install Abaqus and how to configure the installation for particular

circumstances. Some of this information, of most relevance to users, is also provided in the

Abaqus Analysis User’s Manual.

1.1.9 Abaqus Keywords Reference Manual

This manual contains a complete description of all the input options that are available in Abaqus/Standard

and Abaqus/Explicit.

1.1.10 Abaqus Theory Manual

This manual contains detailed, precise discussions of all theoretical aspects of Abaqus. It is written to

be understood by users with an engineering background.

1–3
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1.1.11 Abaqus Verification Manual

This manual describes basic test cases, providing verification of each individual program feature

(procedures, output options, MPCs, etc.) against exact calculations and other published results. It may

be useful to run these problems when learning to use a new capability. In addition, the supplied input

data files provide good starting points to check the behavior of elements, materials, etc.

1.1.12 Abaqus User Subroutines Reference Manual

This manual provides a complete description of all the user subroutines available for use in Abaqus

analyses. It also discusses the utility routines that can be used when writing user subroutines.

1.1.13 Abaqus Glossary

This manual defines technical terms as they apply to the Abaqus Unified FEA Product Suite.

1.1.14 Abaqus Scripting User’s Manual

This manual provides a description of the Abaqus Scripting Interface, which is an application

programming interface (API) to the models and data used by Abaqus. The manual describes how

commands can be used to create and analyze Abaqus/CAE models, to view the results of the analysis,

and to automate repetitive tasks. It also contains information on using the Abaqus Scripting Interface

or C++ as an API to the output database.

1.1.15 Abaqus Scripting Reference Manual

This manual provides a command reference that lists the syntax of each command in the Abaqus Scripting

Interface.

1.1.16 Abaqus GUI Toolkit User’s Manual

This manual provides a description of the Abaqus GUI Toolkit, which allows you to customize the

Abaqus/CAE Graphical User Interface by creating your own dialog boxes, GUI modules, and even

applications. The manual explains how to use the components of the toolkit by providing snippets of

example code.

1–4
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1.1.17 Abaqus GUI Toolkit Reference Manual

This manual provides a complete listing of the Abaqus GUI Toolkit programming interface, but it does

not describe how to use the toolkit. For an explanation of how to use the Abaqus GUI Toolkit see the

Abaqus GUI Toolkit User’s Manual.

1.1.18 Abaqus Interface for MSC.ADAMS User’s Manual

This manual describes how to use the Abaqus Interface for MSC.ADAMS, which creates Abaqus models

of MSC.ADAMS components and converts the Abaqus results into an MSC.ADAMS modal neutral file

that can be used by the ADAMS/Flex program.

1.1.19 Abaqus Interface for Moldflow User’s Manual

This manual describes how to use the Abaqus Interface for Moldflow, which creates a partial Abaqus

input file by translating results from a Moldflow polymer processing simulation.

1.1.20 Abaqus Release Notes

This manual contains brief descriptions of the new features available in the latest release of the Abaqus

product line.

1–5
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Part II: Using the Abaqus HTML Documentation

• Chapter 2, “Overview of the Abaqus HTML documentation”

• Chapter 3, “Navigating in the Abaqus HTML documentation”

• Chapter 4, “Searching the Abaqus HTML documentation”
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OVERVIEW OF THE Abaqus HTML DOCUMENTATION

2. Overview of the Abaqus HTML documentation

This section explains how to access and use the Abaqus HTML documentation. The following topics

are covered:

• “Viewing the Abaqus HTML documentation,” Section 2.1

• “The Abaqus HTML documentation collection page,” Section 2.2

• “Opening an HTML book from the collection window,” Section 2.3

• “Viewing the book window,” Section 2.4

• “Opening an HTML book from another HTML book,” Section 2.5

• “Modifying the width of the table of contents frame,” Section 2.6

• “Using your browser settings,” Section 2.7

• “Printing from an HTML book,” Section 2.8

2.1 Viewing the Abaqus HTML documentation

The Abaqus HTML documentation collection allows you to view Abaqus documentation through a

Web browser. You can also view specific sections of the HTML documentation when you request

context-sensitive help from within Abaqus/CAE or Abaqus/Viewer. For information about using

context-sensitive help, see “Displaying context-sensitive help,” Section 2.6.1 of the Abaqus/CAE

User’s Manual.

Note: Links to the HTML documentation from context-sensitive help function only if you have installed

the HTML documentation files and have entered the path to the documentation installation.

If you have installed Abaqus products on your computer, you can use one of the following methods to

access the Abaqus HTML documentation:

• Type abaqus doc at the system prompt, where abaqus is the command to run Abaqus.

• In Abaqus/CAE, select Search & Browse Manuals from the Help menu on the main menu bar.

On Windows platforms, if you have Abaqus HTML documentation installed on your computer, the

following shortcut may be available from the Start menu:

Programs→Abaqus 6.10 HTML Documentation→Documentation

If you do not have Abaqus products or Abaqus documentation installed on your computer, contact your

system administrator for the URL for the Abaqus HTML documentation collection on your network. For

quick access to the documentation, save the location as a bookmark in your browser.

For information on installing the HTML documentation, see Chapter 2, “Installing Abaqus,” of the

Abaqus Installation and Licensing Guide.

2–1
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2.2 The Abaqus HTML documentation collection page

The Abaqus HTML documentation books are available from a collection page. When you open the

documentation in your Web browser, the collection window appears.

The top frame of the collection window contains a search function (see Chapter 4, “Searching the

Abaqus HTML documentation”); a link to the SIMULIA Online Support System, which is accessible

through the My Support page at www.simulia.com; the icon, which allows you to display

information on browser version support and the documentation release; the icon, which allows you

to open the Abaqus PDF documentation collection; a link to the Advanced Search options; and a link

to tips for searching the Abaqus HTML documentation collection.

The collection window lists all the book titles in the collection, grouped by function, as shown in

Figure 2–1.

Figure 2–1 The Abaqus HTML documentation collection window.

2–2
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To see brief descriptions of each book, hold the cursor over the book titles in the collection. For example,

if you hold the cursor over the title for the Abaqus Analysis User’s Manual, the following description

appears:

2.3 Opening an HTML book from the collection window

When you click the title of a book in the collection window, a book window opens in a new browser

window or tab, depending on the browser setting.

Note: You can open additional book windows from the collection window by clicking the book titles.

The book windows will remain open until you close them. You can open one window to each book from

the collection window.

See “Opening an HTML book from another HTML book,” Section 2.5, for information about using

the list box of book titles in the navigation frame to open another book from a book window.

2.4 Viewing the book window

The book window contains four frames: the navigation frame (top frame), the table of contents frame

(left frame), the table of contents control frame (directly above the table of contents frame), and the text

frame (right frame). The title of the book appears in the list box located at the top of the navigation

frame. Figure 2–2 shows a sample book window. You can access the collection window from any book

in the collection by selecting Abaqus 6.10 Documentation Collection from the top of the list of book

titles in the list box in the navigation frame.

In addition to the list box of book titles, the navigation frame contains a search function (see

Chapter 4, “Searching the Abaqus HTML documentation”), a print function (see “Printing from an

HTML book,” Section 2.8), a link to tips for searching the Abaqus HTML documentation collection,

a link to the Advanced Search options (see “Using the Advanced Search options,” Section 4.5),

2–3
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list boxsearch field

navigation
frame

text frame

table of contents
control frame

table of contents
frame

Figure 2–2 A sample HTML book window.

and information about the HTML documentation (click the icon to display information on browser

version support and the documentation release).

2.5 Opening an HTML book from another HTML book

You can open another book from a book window by clicking the arrow in the list box at the top of the

navigation frame to display a pull-down list of book titles and selecting a different book title. The book

previously displayed in the book window closes, and the newly selected book opens in the same browser

window.

Note: Choosing another book title from the pull-down list closes the book from which you selected the

new book title. It does not close any previously opened book. For example, if you minimize a copy

of the Abaqus/CAE User’s Manual, open the Abaqus Analysis User’s Manual from the collection page,

and select the Abaqus/CAE User’s Manual from the pull-down list at the top of the Abaqus Analysis

User’s Manual, the Abaqus Analysis User’s Manual closes and a second copy of the Abaqus/CAE User’s

Manual opens.

You can minimize a book from the collection and then bring that book to the forefront when you click

a link to its content from another book window or from the collection page. The minimized window

2–4
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reopens on top of the current window with the target page displayed. In addition, you can bring an open

book window to the foreground by clicking a link to its content from another book window or from the

collection page. The window opens on top of the current window with the link target page displayed.

2.6 Modifying the width of the table of contents frame

You can change the width of the table of contents frame and the text frame by dragging the dividing line

between the frames to the right or left or by clicking the tool or the tool in the table of contents

controls frame. To return the frames to their default sizes, click the browser window’s reload or refresh

button.

In addition, you can use the and tools in the table of contents control frame to vary the level

of detail displayed in the table of contents frame (see “Expanding or collapsing the table of contents,”

Section 3.1.1.)

2.7 Using your browser settings

Your browser settings will affect the look of the HTML documentation; for example, your browser

may be set to ignore or override the colors, font styles, or font sizes specified by the Abaqus HTML

documentation. You will use the browser functions for common tasks such as resizing book windows

and frames. See your browser help for more information.

2.8 Printing from an HTML book

The HTML documentation is broken into HTML pages, which are the scrollable content of the text

frames in a book window. You can print only one page at a time using the HTML documentation.

Highlighting that appears in the text frame after searching an HTML book does not appear in the printed

document.

For information about printing a range of pages or obtaining a higher quality printed copy, see

“Printing from a PDF book,” Section 5.3.

To print from an HTML book:

1. In the navigation frame of the book window, click the icon.

The browser’s print dialog box appears.

2. Specify the printing options.

2–5
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3. Navigating in the Abaqus HTML documentation

This section explains how to navigate in the Abaqus HTML documentation. The following topics are

covered:

• “Locating information in the Abaqus HTML documentation,” Section 3.1

• “Using the table of contents frame,” Section 3.2

3.1 Locating information in the Abaqus HTML documentation

There are several useful techniques for locating information within a book in the HTML collection. The

following topics are covered:

• “Expanding or collapsing the table of contents,” Section 3.1.1

• “Browsing,” Section 3.1.2

• “Searching,” Section 3.1.3

3.1.1 Expanding or collapsing the table of contents

Use the tools in the table of contents control frame to vary the level of detail displayed in the table of

contents frame. Click the tool to expand several levels in the table of contents of an HTML book.

Click the tool to collapse all expanded sections in the table of contents.

The tool expands the table of contents entries to a default level of expansion. Clicking the

tool an additional time will have no effect. Individual sections can be expanded by clicking book icons

as described in “Using the table of contents frame,” Section 3.2. However, if you collapse one or all of

the entries, you can use the tool to reopen the closed sections to the default level of expansion.

Note: The default level of expansion is not the same for each book. The default expansion levels were

chosen to balance usefulness and performance based on the size and content of each book.

3.1.2 Browsing

Use the and arrows in the text frame to navigate sequentially to the previous and next HTML

page. You can also use the Web browser functions to return to recently viewed pages.

3–1
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3.1.3 Searching

Use the Search text field in the navigation frame to search for specific terms or phrases. You can conduct

searches of the Abaqus HTML documentation from the book window or from the collection window.

See Chapter 4, “Searching the Abaqus HTML documentation,” for more information.

3.2 Using the table of contents frame

The table of contents frame on the left side of the book window contains a hierarchical outline of the

topics in the book. This outline allows you to move quickly from one part of the book to another. When

you click a table of contents entry, the table of contents entry becomes highlighted and the text frame

displays the corresponding section in the book (see Figure 3–1). As you navigate through the book, the

highlighting in the table of contents frame moves, indicating your location within the book.

Figure 3–1 The table of contents entry is highlighted, and the text

frame displays the corresponding section in the text frame.

3–2
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The table of contents can display varying levels of detail. You can choose to display only major

topic headings or to expand any or all of the topic headings to show subtopic headings as well. To expand

an individual section of the table of contents, click to the left of the topic heading. The headings of

the subtopics appear under the topic heading, and the sign changes to (see Figure 3–1), indicating that

the section is expanded. If appears beside a subsection, there are no further levels within that section

to expand. To collapse an expanded section of the table of contents, click next to the topic heading.

In addition, you can use the and tools to expand or collapse topic and subtopic headings in a

book to the default level of expansion.
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4. Searching the Abaqus HTML documentation

This section contains information about searching the Abaqus HTML documentation. The following

topics are covered:

• “Search terms and search phrases,” Section 4.1

• “Conducting a search from the book window,” Section 4.2

• “Conducting a search from the collection window,” Section 4.3

• “HTML search details,” Section 4.4

• “Using the Advanced Search options,” Section 4.5

• “Search strategies,” Section 4.6

4.1 Search terms and search phrases

Search terms are individual words or strings of letters and characters with no white space. Search phrases

are multiple terms that are enclosed in double quotation marks to indicate that terms will be found in a

specific order. You can enter one or more search terms in the search field. If multiple search terms are

entered without quotation marks around the words, the search procedure displays hits where:

• The search terms appear in any order.

• The search terms may or may not be adjacent.

• All search terms appear within a section or subsection (see “Default search proximity and

highlighting,” Section 4.1.1).

• Advanced search allows you to control the proximity range (see “Limiting the search results by

proximity or context,” Section 4.5.3).

For example, if you search for finite strain, you will find occurrences of “finite” and “strain”

within the proximity range; the result is order independent.

Search phrases are made up ofmultiple search terms enclosed in double quotationmarks. The search

procedure displays hits only when the documentation contains an exact match of the phrase in the search

field. For example, if you search for “finite strain”, you will find occurrences of “finite strain.”

This search will not locate occurrences of the phrase “finite plastic strain.” For additional information

about searching techniques, see “HTML search details,” Section 4.4, and “Using the Advanced Search
options,” Section 4.5.

You can combine search terms and search phrases in a single search procedure. For example, if you

search for plastic “finite strain”, you will find occurrences of “finite strain” and “plastic”

within the proximity range.
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4.1.1 Default search proximity and highlighting

The default search proximity range is used when you search for multiple terms and when you use the

advanced search options to search for one term without another. In most Abaqus manuals the default

search proximity range corresponds to the smallest section size that appears in the table of contents for

that book. However, the following manuals use a slightly different default proximity range:

• Abaqus Analysis User’s Manual

• Abaqus/CAE User’s Manual

• Abaqus Keywords Reference Manual

• Abaqus Glossary

• Abaqus GUI Toolkit Reference Manual

• This manual (Using Abaqus Online Documentation)

For these books, the search proximity and search term highlighting are controlled by larger sections

within the table of contents; you may notice these sections if you expand the table of contents after

searching for a commonly used term and find a hit count next to the title of a larger section but no hits

displayed for its subsections.

To locate search results in any book, you should use the table of contents to open a section that

indicates a number of search hits and scroll through the section or use the Next Match and Previous
Match buttons to locate highlighted search terms.

Note: If you click a section title in the table of contents for which no search hits are displayed, the section
will open without search hit highlighting, even if search hits are included as part of a larger scrollable

HTML page.

4.1.2 Using search terms and phrases

Use search terms without quotes for broad searching or to locate words that occur infrequently. Use

search phrases to narrow a search or to locate specific information related to words that appear frequently

in the documentation.

4.2 Conducting a search from the book window

The Search text field in the navigation frame (see Figure 4–1) of the book window allows you to search

for a particular term or phrase in a book.
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search field

Figure 4–1 The navigation frame of the book window.

To conduct a search:

1. Type the term or phrase into the Search text field, and press [Enter] or click Search.

An hourglass icon displays while the search is in progress. When the search is complete, the table

of contents frame displays the number of hits next to each topic heading and the title of the current

section is highlighted in the table of contents frame. In addition, all hits become highlighted in the

text frame (see Figure 4–2). If the search is unsuccessful, a message indicates that no hits were

found.

Figure 4–2 Search hits displayed in the table of contents frame and the book window.
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2. If the search is successful, click Next Match or Previous Match in the navigation frame to

move forward through the document from one hit to the next. As you step through each hit, the

highlighting color of the hit that you are viewing is different from that of the remaining hits. When

you move from one section to another, the highlighting in the table of contents frame moves to the

new section.

3. If desired, use the table of contents frame to move to a relevant section in the book and then click

Next Match or Previous Match to continue the search process.

If you open another book in the collection, the browser repeats the previous search in the newly opened

book.

To clear the Search text field and to remove highlighting from the text frame and search feedback

from the table of contents frame, click Clear Search in the navigation frame. To stop a search before

the process is complete, click the icon in the navigation frame.

For information about using Advanced Search to focus your search, see “Using the Advanced
Search options,” Section 4.5. For information about using strategies to decide which search results are

most likely to help you, see “Search strategies,” Section 4.6.

4.3 Conducting a search from the collection window

The Search All Books text field in the navigation frame (see Figure 4–3) of the collection window

allows you to search all the books in the HTML collection.

Figure 4–3 The navigation frame of the collection window.

The collection window search function works the same way as the book window search function; that

is, you type a particular term or phrase into the text field, and press [Enter] or click Search All Books.
An hourglass icon displays while the search is in progress. When the collection search is complete, the

number of hits that match your search criteria in each book appears to the left of the book titles (see

Figure 4–4).
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Figure 4–4 Search hits displayed in the collection window.

If the search is unsuccessful, a message indicates that no hits were found.

To view the search results in a book, click a book title in the collection window. The book opens

with the search term or phrase in the Search text field and the number of hits in the book displayed in the

table of contents frame (see Figure 4–5). Click Next Match or Previous Match in the navigation frame

to move through the document from one hit to the next. As you step through each hit, the highlighting

color of the hit that you are viewing is different from that of the remaining hits. When you move from

one section to another, the highlighting in the table of contents frame moves to the new section.

For information about using Advanced Search to focus your search, see “Using the Advanced
Search options,” Section 4.5. For information about using strategies to decide which search results are

most likely to help you, see “Search strategies,” Section 4.6.

4.4 HTML search details

The search function is insensitive to case, so capitalizing any letter has no effect on the search results.

The basic search function exhibits the following behaviors:
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Figure 4–5 Search hits displayed in the book window.

Word match criterion

The basic search function matches the exact spelling of each word that you have typed in the search

text field. For example:

Searching for element will find

element

Element

ELEMENT

Variations from the root word “element”—such as “elements,” “elemental,” or “elementary”—are

not found by the default search. You can use an Advanced Search option that widens the

search by increasing the number of word forms that are found (see “Search word match criteria,”

Section 4.5.4).
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Proximity

If you enter more than one word in the Search text field, the default search function finds those

words inside the default proximity range, which varies from book to book (see “Search terms and

search phrases,” Section 4.1). For example:

Searching for twist beam will find

Occurrences of “twist” and “beam”

You can use an Advanced Search option that narrows the search by finding words inside the same

paragraph or sentence (see “Limiting the search results by proximity or context,” Section 4.5.3).

Matching phrases

You can search for words that appear in a specific order by placing them between double quotation

marks. You can also place a hyphen (-) between the words in the Search text field to search for

words that contain a hyphen. For example:

Searching for “cut loft feature” will find

cut loft feature

Searching for step-dependent will find

step-dependent

step dependent

The use of quotation marks controls word order only, not word variations. See “Using the

Advanced Search options,” Section 4.5, for information about searching for word derivations.

Wildcard characters (*/?)

The wildcard character (*) can stand for any character or set of characters and enables you to search

for words or phrases that contain certain letters or patterns of letters. For example:

Searching for hy*lastic will find

hyperelastic, hyperelasticity, HYPERELASTIC

hypoelastic, hypoelasticity, HYPOELASTIC

Such a search will also find a string of words that include “hy” and “lastic,” such as

“hyperbolic Drucker-Prager plasticity.”

Searching for hyper* will find

hyperbolic

hyperelastic, hyperelasticity, HYPERELASTIC

hyperfoam, HYPERFOAM

hyperlinks
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Since the wildcard character (*) has special meaning in the search language, the following restrictions

apply:

• You cannot search for words and phrases containing a wildcard character.

• You cannot use a wildcard character as the first character in a search term.

• You cannot use a wildcard character to search exclusively for occurrences of keywords in the text.

For example, you cannot search for *lastic or *ELASTIC. However, you can search for an Abaqus

keyword by using an Advanced Search option. For more information, see “Narrowing the focus of a

search,” Section 4.5.2.

The wildcard character (?) is commonly used as a single-character replacement wildcard in other

search engines. It is not used in the Abaqus search engine.

4.4.1 What text is included in a search?

The search function searches almost all the text you can scroll through in the text frame of a book

window, including section titles, hyperlinks, and figure titles. Text that appears in equations, graphics

and captions, and page headings is excluded from the search function. In addition, text that appears in

the introductory sections of each book, such as the Preface, is excluded from the HTML documentation

search function. You can use the browser’s search function to search the introductory sections.

The Abaqus HTML documentation search function automatically ignores the words “a” and “the.”

You can search for phrases that include “a” and “the” by enclosing the search phrase in quotation marks.

Note: Using quotations marks around “a” or “the” alone produces no hits.

You cannot search for punctuation marks alone or for punctuation marks enclosed by quotation

marks. You can search for punctuation marks such as periods or commas as part of a search phrase

that is enclosed by quotation marks. You can also search for words connected by a hyphen without the

surrounding quotation marks. However, punctuation marks such as periods, commas, or hyphens cannot

be the first or last character of the search phrase.

You can search for special characters, but you must use a blackslash before the character. You can

search for the following special characters, preceded by a backslash:

%

@

\

/

#
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4.5 Using the Advanced Search options

This section contains information on using the Advanced Search options available in the Abaqus

HTML documentation in both the book and collection windows. Click Advanced Search in the

navigation frame to display the Advanced Search window.

Figure 4–6 The Advanced Search window.

The Advanced Search window allows you to vary the default search behavior. The following topics

are covered:

• “Excluding unwanted terms,” Section 4.5.1

• “Narrowing the focus of a search,” Section 4.5.2

• “Limiting the search results by proximity or context,” Section 4.5.3

• “Search word match criteria,” Section 4.5.4

For information about basic search behavior and search procedures, see “HTML search details,”

Section 4.4.

4.5.1 Excluding unwanted terms
To remove unwanted terms from the search, enter those terms in the Without the text field of the

Advanced Search window. For example, you can search for occurrences of “continuum” without

“shell” inside the same section, as shown in Figure 4–7.
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Figure 4–7 Using the Advanced Search window to remove terms.

4.5.2 Narrowing the focus of a search

Use the Advanced Search options to restrict a search to a particular context. Occurrences of the search

phrase that do not appear in that context are not included in the search results. The list of available search

filters appears when you click the Limit search to menu button. By default, the search function locates

words in All searchable text. To limit your search, choose from the following options (see Figure 4–8):

Figure 4–8 The Limit search to menu in the Advanced Search window.
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• Abaqus keywords: Keywords (also known as “options”) are preceded by an asterisk and appear

in uppercase letters in the Abaqus documentation. *SOLID SECTION is an example of an Abaqus

keyword.

• Abaqus parameters: In Abaqus/Standard and Abaqus/Explicit the term is used to refer to a

parameter that follows a keyword in an Abaqus input file. Keyword parameters, which can be

optional or required, provide additional information concerning the keyword. NLGEOM is an

example of an Abaqus parameter. This option also finds execution command line parameters, such

as job.

• Parameter values: The value of an Abaqus parameter. NEW is an example of an Abaqus

parameter value.

• User subroutine names: User subroutines are subroutines you write to increase the functionality
of Abaqus options for which data line usage may be too restrictive. User subroutines are typically

written as FORTRAN code. CREEP is an example of an Abaqus user subroutine.

• MPC names: MPCs (multi-point constraints) allow constraints to be imposed between different

degrees of freedom of the model. BEAM is an example of an Abaqus MPC.

• Connector names: Connector elements in Abaqus provide an easy and versatile way to model

many types of physical mechanisms whose geometry is discrete (i.e., node-to-node), yet the

kinematic and kinetic relationships describing the connection are complex. REVOLUTE is an

example of an Abaqus connector element.

• GUI text: GUI text includes buttons and labels. Interference Fit is an example of GUI text.

• Abaqus Scripting Interface object: A Python object defined by the Abaqus Scripting Interface.

MeshEdge is an example of a Python object.

For example, if you are looking for the *ELASTIC keyword and not just any occurrence of the word

“elastic,” type elastic in the Search text field and select the Abaqus keywords search filter. The

search function finds only cases where the word appears as part of a keyword name, such as *ELASTIC

and *POROUS ELASTIC. If you type elastic in the Search text field without using a search filter,

the search result includes any usage of the word “elastic.” If you are looking for occurrences of the word

“creep” and you select the Abaqus keywords search filter, the search function finds only cases where

the word appears as part of a keyword name, such as *CREEP and *CREEP STRAIN. If you select the

User subroutine names search filter, the search function finds only cases where the word is used as

the name of user subroutine CREEP.

4.5.3 Limiting the search results by proximity or context
To search for a particular word or phrase near another word or phrase, use the Display occurrences
within menu button. By default, the search function locates multiple search terms that appear inside the

same section. To control the area within which all words listed in the Search text field must appear,

choose from the following options (see Figure 4–9):

4–11

Abaqus ID:

Printed on:



SEARCHING THE Abaqus HTML DOCUMENTATION

• The same section: (the default) this option locates multiple search terms that appear in any

order within the default proximity range. (For more information, see “Default search proximity

and highlighting,” Section 4.1.1.)

• The same paragraph: this option locates multiple search terms that appear in any order within

the same paragraph.

• The same sentence: this option locates multiple search terms that appear in any order within the

same sentence.

Figure 4–9 The Display occurrences within search menu in the Advanced Search window.

In addition, you can search for words that appear within the following blocks of text:

• Titles: this option locates a word or multiple search terms that appear in any order within any

section title.

• Abaqus/CAE usage examples: this option locates a word or multiple search terms that appear

in any order within sections in the Abaqus Analysis User’s Manual and the Abaqus Release Notes

that explain how to complete a specific procedure using Abaqus/CAE.

• Input file usage examples: this option locates a word or multiple search terms that appear in any

order within sections in the Abaqus Analysis User’s Manual that explain how to complete a specific

procedure using the keyword interface.

If the number of hits seems excessive, you can add more words to the Search text field or select another

option to narrow the search.
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4.5.4 Search word match criteria
To select the word form or derivative words that the search function will match, use the Match parameter.

By default, the search function matches the exact spelling of the search term or phrases. The search

function is insensitive to case. To change the word match selection, choose from the following options

(see Figure 4–10):

• Exact spelling: (default) this options finds only exact spelling matches.

• Plural/Possessive: this option finds words containing s, es, ’s, and s’; to find such words in a

specific order, use quotation marks and Plural/Possessive.

• Derived form: this option finds any words that can be derived from the search word; to find such

words in a specific order, use quotation marks and Derived form.

Figure 4–10 The Match parameter in the Advanced Search window.

For example, a search for the word “element” produces the following results, depending on the match

parameter selected:

• Exact spelling finds

element

• Plural/Possessive finds

element

elements

element’s

elements’

• Derived form finds

element

elements

4–13

Abaqus ID:

Printed on:



SEARCHING THE Abaqus HTML DOCUMENTATION

elem

elementary

elemental

If the search returns no hits or the number of hits seems low, widen the search by increasing the number

of word forms that the search function attempts to locate.

4.6 Search strategies

The best strategy for locating information in the Abaqus HTML documentation involves a combination

of searching for terms or phrases, determining the appropriate book or books to view, and using the table

of contents to navigate to the most likely area. The Abaqus HTML documentation allows you to search

at both the book level and the collection level. Familiarity with the overall structure of the documentation

collection contents significantly enhances the effectiveness of searching.

This section discusses strategies to help you maximize the effectiveness of searches in the Abaqus

HTML collection. The following topics are covered:

• “Determining which book to view,” Section 4.6.1

• “Determining which part of the book to view,” Section 4.6.2

• “Specifying relevant search terms and using the table of contents to navigate search results,”

Section 4.6.3

4.6.1 Determining which book to view

The book containing the most search results may not have the information for which you are searching.

You will obtain search results faster if you are able to identify which book most likely contains the

information you need. For example, if you are looking for information related to interactive modeling

or visualization procedures, start by searching the Abaqus/CAE User’s Manual. If you are looking for

details on a specific analysis type or procedure, start with a search of the Abaqus Analysis User’s Manual.

If you are looking for an example of an analysis, start by searching the Abaqus Example ProblemsManual

or the Abaqus Benchmarks Manual.

If you are not sure where to start, you can search the collection level and see how many related hits

occur in each book; the number of hits in each book on a particular topic may provide some guidance.

For more information about the books in the documentation collection, see “The Abaqus

documentation collection,” Section 1.1.
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4.6.2 Determining which part of the book to view

When performing a search, you can use the table of contents to find the most relevant hits. The total

number of hits in the book are displayed next to the book title, which is the first entry in the table of

contents. If you find many hits and are unsure where to look in the book, collapse the table of contents

and look for sections with the highest number of hits. Look for section titles related to your search topic,

and expand those sections. In addition, you can use the Advanced Search options to search for titles

that may help identify relevant sections.

4.6.3 Specifying relevant search terms and using the table of contents
to navigate search results

Specifying relevant search terms is critical to locating information. New users performing general

searches should begin with obvious search terms and navigate the search results using the number of

hits shown in the table of contents frame as a guide along with titles in the table of contents. As the

search proceeds, more specific terms can be added to narrow the results (see “Narrowing the focus of a

search,” Section 4.5.2, for more information).

For example, if you are looking for general information on elements, you could search for elements

at the collection level. This will produce large numbers of hits in essentially every manual. If you are

looking for information about new elements, open the Abaqus Release Notes. If you are looking for an

overview of the Abaqus element library, open the Abaqus Analysis User’s Manual. Expand the chapters

on elements, and navigate using the table of contents or refine the search terms to look for more specific

information. In addition, add terms such as “continuum shell” or “solid” to refine the search.
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5. Overview of the Abaqus PDF documentation

This section explains how to access and how to use the Abaqus PDF documentation. The following

topics are covered:

• “Viewing the Abaqus PDF documentation,” Section 5.1

• “Locating information in the PDF documentation,” Section 5.2

• “Printing from a PDF book,” Section 5.3

5.1 Viewing the Abaqus PDF documentation

The Abaqus documentation is available in portable document format (PDF) as an optional supplement

to the online documentation in HTML format. Both the HTML and PDF documentation collections can

be installed using the Abaqus installer (see Chapter 2, “Installing Abaqus,” of the Abaqus Installation

and Licensing Guide).

You can use a PDF viewer, such as Adobe Reader, to view the PDF documentation files. The

following PDF viewers are recommended for viewing the Abaqus PDF documentation:

• Adobe Reader 8 or 9 on Windows and Linux x86-64 platforms

• Adobe Reader 7 on Linux/Itanium and UNIX platforms

Note: To view current information on platform support for PDF viewers, consult the System
Information section of the Support page at www.simulia.com.

The ability to view PDF documents on a particular platform depends on the availability of PDF

viewer software on that platform. Search capabilities in PDF viewers vary from platform to platform

and with the viewer software version.

To view the Abaqus PDF documentation on Windows platforms:

1. Use the Start menu shortcut:

Programs→Abaqus 6.10 Documentation→PDF Documentation

2. Alternatively, you can open the collection index file (index.pdf) directly in your PDF viewer.

• If the HTML and PDF documentation were installed, the PDF index file is located in the

following subdirectory under the SIMULIA installation directory:

simulia_dir\Documentation\docs\v6.10\pdf_books\index.pdf

• If only the PDF documentation was installed, the PDF index file is located in the following

subdirectory:

simulia_dir\Documentation\pdf_docs\v6.10\index.pdf
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3. Click a title to open an individual book, or use the search function to search the PDF documentation

collection.

Note: The PDF collection index file can also be accessed from within the HTML documentation

by clicking the Adobe PDF file icon in the upper right corner of the HTML collection index file

(index.html).

To view the Abaqus PDF documentation on Linux platforms:

1. Open the collection index file (index.pdf) directly in your PDF viewer.

• If the HTML and PDF documentation were installed, the PDF index file is located in the

following subdirectory under the SIMULIA installation directory:

simulia_dir/Documentation/docs/v6.10/pdf_books/index.pdf

• If only the PDF documentation was installed, the PDF index file is located in the following

subdirectory:

simulia_dir/Documentation/pdf_docs/v6.10/index.pdf

2. Click a title to open an individual book, or use the search function to search the PDF documentation

collection.

Note: The PDF collection index file can also be accessed from within the HTML documentation

by clicking the Adobe PDF file icon in the upper right corner of the HTML collection index file

(index.html).

5.2 Locating information in the PDF documentation

There are several useful navigation techniques for locating information within the PDF documentation

collection.

Navigating

Use the Page Navigation toolbar (see Figure 5–1) to navigate through documents. You can also

use menu commands and keyboard shortcuts for paging through documents. See Adobe Reader
Help for more information.

Figure 5–1 Acrobat navigation controls.
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Using bookmarks

You can display the bookmarks in the navigation pane that represent a hierarchical outline of the

topics in the book (see Figure 5–2).

Figure 5–2 Bookmarks in the navigation pane.

This outline allows you to move quickly from one part of the book to another. When you click a

bookmark, the text frame displays the corresponding section in the book. To display the bookmarks,

click the Bookmarks tab on the left side of the Adobe Reader window.

The bookmarks can display varying levels of detail. You can choose to display only major

topic headings or to expand any or all of the topic headings to show subtopic headings as well. To

expand an individual section of the bookmarks, click the plus sign (+) to the left of the topic heading.

The headings of the subtopics appear under the topic heading. To collapse an expanded section of

the bookmarks, click the minus sign (−) next to the topic heading.

Searching

Use the Find toolbar (open by default) or the Search window (see Figure 5–3) to search for specific

words or phrases.
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Figure 5–3 The Acrobat Reader Search window.

To open the Search window, select Edit→Search from the main menu bar or click the arrow

in the Find toolbar and select Open Full Reader Search.See Chapter 6, “Searching the PDF

documentation,” for more information.

5.3 Printing from a PDF book

The PDF documentation produces a higher quality printed copy than the HTML documentation. There

are two methods for printing from the Abaqus PDF documentation:

• “Using the print function in the PDF viewer,” Section 5.3.1

• “Printing an entire section of a PDF book,” Section 5.3.2
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Note: You cannot use an Adobe print driver to create a copy of the Abaqus PDF documentation.

Although the books can be sent to a printer to produce a hard copy, the books are stored in an encrypted

format that produces an error if the files are sent to an Adobe print driver.

5.3.1 Using the print function in the PDF viewer

You can use the print function in the PDF viewer to print one or more pages of the PDF documentation. To

print selected sections of the manual, use the navigation controls and bookmarks to identify the starting

and end page numbers in the PDF document, then specify the pages to be printed in the Print dialog box.

To print from a PDF book:

1. Select File→Print from the main menu bar, or click the icon on the toolbar.

The Print dialog box appears.

2. Specify the printing options.

5.3.2 Printing an entire section of a PDF book

All books in the Abaqus PDF collection except the Abaqus Scripting Reference Manual and the Abaqus

GUI Toolkit Reference Manual contain a icon in the top left corner of each page that allows you

to print a selected section without specifying a page range.

To print an entire section:

1. In the section you wish to print, click the icon on any page in the section.

2. In the dialog box that appears, confirm the printer you are using, the section number and title of the

PDF section to be printed, and the page range of the section to be printed.

• To print the section using the default settings, click Yes.

• To select a different printer, click No and select the desired printer in the Print Setup dialog

box.

• To print a different section, click Cancel to cancel the print job, navigate to the appropriate

section, and click the icon in that section.
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6. Searching the PDF documentation

The capabilities of the search function vary widely depending on the PDF viewer, viewer version, and

platform. This section explains how to conduct searches using Adobe Reader 8 or 9 for Windows

platforms.

Adobe Reader offers two levels of search options: basic search options and advanced search options.

Use of the advanced search options allows you to use indexed searching to accelerate the search process.

The following topics are covered:

• “Indexed searching with Adobe Reader,” Section 6.1

• “Conducting a search of a single PDF book or the entire PDF collection,” Section 6.2

For information on conducting searches using other PDF viewers, refer to the user documentation for

those applications.

6.1 Indexed searching with Adobe Reader

The Abaqus PDF documentation includes a compiled search index (index_610.pdx) to enable

accelerated collection-level documentation searches. Searching this index is much faster than searching

all the text in the individual books. If possible, you should use this approach for searching the Abaqus

PDF documentation. Adobe Reader 8 and 9 for Windows provide the indexed searching capability.

Note: To use indexed searching, you must open Adobe Reader from your desktop rather than from

within your web browser.

The index name associated with the index_610.pdx file is Abaqus 6.10 PDF
Documentation. A search of the Abaqus 6.10 PDF Documentation index produces a

results list with links to the occurrences in the individual books.

By default, when you open the Search window, the basic search options are displayed and you

can search the current PDF document or search a folder containing the entire PDF collection. To search

an index, you must use the advanced search options. To display the advanced search options, click

Use Advanced Search Options or reset your preferences by selecting Edit→Preferences from the

main menu bar, selecting Search from the list of Categories, and toggling on Always use advanced
search options.

6.1.1 Conducting a search of the Abaqus compiled search index

Use the following procedure to conduct a search of a PDF index:

1. Display the Search window in one of two ways:
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• Select Edit→Search from the main menu bar

• Click the arrow in the Find toolbar, and select Open Full Reader Search.

The Search window appears.

2. In the search field labeled What word or phrase would you like to search for?, enter the word
or phrase that you want to find.

3. Click the arrow to the right of the Return results containing field, and select one of the following

options:

Match Exact word or phrase

This search option finds the exact form and the plural form of each word that you type in the

search field. The option searches for the entire string of characters, including spaces, in the

order in which they were typed. For example, searching for element will find

element, elements

Element, Elements

ELEMENT, ELEMENTS

Words that are formed from “element”—such as “elemental” or “elementary”—are not found

by the search.

Match Any of the words

This search option finds any of the words that you type in the search field as well as different

forms of each word. For example, searching for metal plasticity will find

• metal plasticity, Metal Plasticity

• metal, Metal

• plasticity, Plasticity

• viscoplasticity, Viscoplasticity

4. Click the arrow to the right of the Look In field, and select Select Index.

The Index selection dialog box appears.

5. In the Index selection dialog box:

a. Select the Abaqus 6.10 PDF Documentation index.

Once the index has been selected, Adobe Reader saves the selection.

b. If the index is not listed, click Add, locate the index_610.pdx file, and click Open.

c. Verify that no other indexes are selected.

d. Click OK to close the Index selection dialog box.

6. Select any of the additional search criteria:
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Note: Some of the search characteristics available in Adobe Reader to refine a search are not

appropriate for Abaqus documentation searches.

Whole words only

This search option matches the exact form of each word that you type in the search pane. For

example, searching for element will find

element

Element

ELEMENT

Without this option, you might also find words such as “elements,” “elemental,” and

“elementary.”

Proximity

This option finds search terms that are within 900 words of each other. This option is available

only for multiple document searches or index definition files and if Match All of the words
is selected.

Case-Sensitive

This option finds only occurrences of the words that are in the same case as the word or words

you type in the search field.

Stemming

This option finds words that contain part (the stem) of the specified search word or phrase when

searching in the current file or Acrobat indexes. For example, stemming will find instances of

the search word that end in “ing,” “ed,” “x,” “ion,” and so on.

Note: An exception is the ending “er.” Words ending in “er” are excluded from the search

results.

For example, searching for any form of execut will find

• execute, executes

• executed

• executing

• executable, executables

• execution

7. Click Search.

The search pane displays a list of the results nested under the document names and paths.

8. Sort the search results as desired by clicking the arrow to the right of the Sort by field and selecting

the option of your choice.

9. To expand a list of results for a document, click the plus (+) sign next to a document name.
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10. Click an item from the results list to display the PDF page. Continue clicking items in the results

list, or select Edit→Search Results→Next Result to see the next occurrence.

6.2 Conducting a search of a single PDF book or the entire PDF
collection

This section explains how to conduct a basic or advanced search of a single PDF book or the entire PDF

collection. Use these procedures if indexed searching is not available or if you want to limit your search

to a single book or to a subsection of the collection. The following topics are covered:

• “Conducting a basic or advanced search of a single PDF book,” Section 6.2.1

• “Conducting a search of the entire PDF collection,” Section 6.2.2

6.2.1 Conducting a basic or advanced search of a single PDF book

This section explains how to conduct a basic search of a single PDF book and how to narrow the search

results by conducting an advanced search of a single PDF book. The following procedure explains how

to conduct a basic search of a single PDF book.

1. Enter the word or phrase that you want to find in the Find toolbar, and press Enter.

The search term is highlighted.

2. To see another occurrence of the search term, click Find Next or Find Previous.

The following procedure explains how to conduct an advanced search of a single PDF book.

1. Display the Search window in one of two ways:

• Select Edit→Search from the main menu bar

• Click the arrow in the Find toolbar, and select Open Full Reader Search.

The Search window appears (see Figure 6–1).

2. In the search field labeled What word or phrase would you like to search for?, enter the word
or phrase that you want to find.

3. Click the arrow to the right of the Return results containing field, and select one of the following

options:

Match Exact word or phrase

This search option finds the exact form and the plural form of each word that you type in the

search field. The option searches for the entire string of characters, including spaces, in the

order in which they were typed. For example, searching for element will find
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Figure 6–1 The Search window.

element, elements

Element, Elements

ELEMENT, ELEMENTS

Words that are formed from “element”—such as “elemental” or “elementary”—are not found

by the search.

Match Any of the words

This search option finds any of the words that you type in the search field as well as different

forms of each word. For example, searching for metal plasticity will find

• metal plasticity, Metal Plasticity

• metal, Metal
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• plasticity, Plasticity

• viscoplasticity, Viscoplasticity

4. Click the arrow to the right of the Look In field, and select The Current PDF Document.

5. Select any of the additional search criteria:

Note: Some of the search characteristics available in Adobe Reader to refine a search are not

appropriate for Abaqus documentation searches.

Whole words only

This search option matches the exact form of each word that you type in the search pane. For

example, searching for element will find

element

Element

ELEMENT

Without this option, you might also find words such as “elements,” “elemental,” and

“elementary.”

Proximity

This option finds search terms that are within 900 words of each other. This option is available

only for multiple document searches or index definition files and if Match All of the words
is selected.

Case-Sensitive

This option finds only occurrences of the words that are in the same case as the word or words

you type in the search field.

Stemming

This option finds words that contain part (the stem) of the specified search word or phrase when

searching in the current file or Acrobat indexes. For example, stemming will find instances of

the search word that end in “ing,” “ed,” “x,” “ion,” and so on.

Note: An exception is the ending “er.” Words ending in “er” are excluded from the search

results.

For example, searching for any form of execut will find

• execute, executes

• executed

• executing

• executable, executables

• execution
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6. Click Search.

The search pane displays a list of the results.

7. Click an item from the results list to display the PDF page. Continue clicking items in the results

list, or click Find Next or Find Previous to see the next occurrence.

6.2.2 Conducting a search of the entire PDF collection

This section explains how to conduct a search of the entire PDF collection.

1. Display the Search window in one of two ways:

• Select Edit→Search from the main menu bar.

• Click the arrow in the Find toolbar, and select Open Full Reader Search.

The Search window appears.

2. In the search field labeled What word or phrase would you like to search for?, enter the word
or phrase that you want to find.

3. In the field labeled Look in, select the directory containing the PDF collection.

4. Click the arrow to the right of the Return results containing field, and select one of the following

options:

Match Exact word or phrase

This search option finds the exact form and the plural form of each word that you type in the

search field. The option searches for the entire string of characters, including spaces, in the

order in which they were typed. For example, searching for element will find

element, elements

Element, Elements

ELEMENT, ELEMENTS

Words that are formed from “element”—such as “elemental” or “elementary”—are not found

by the search.

Match Any of the words

This search option finds any of the words that you type in the search field as well as different

forms of each word. For example, searching for metal plasticity will find

• metal plasticity, Metal Plasticity

• metal, Metal

• plasticity, Plasticity

• viscoplasticity, Viscoplasticity
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5. Select any of the additional search criteria:

Note: Some of the search characteristics available in Adobe Reader to refine a search are not

appropriate for Abaqus documentation searches.

Whole words only

This search option matches the exact form of each word that you type in the search pane. For

example, searching for element will find

element

Element

ELEMENT

Without this option, you might also find words such as “elements,” “elemental,” and

“elementary.”

Proximity

This option finds search terms that are within 900 words of each other. This option is available

only for multiple document searches or index definition files and if Match All of the words
is selected.

Case-Sensitive

This option finds only occurrences of the words that are in the same case as the word or words

you type in the search field.

Stemming

This option finds words that contain part (the stem) of the specified search word or phrase when

searching in the current file or Acrobat indexes. For example, stemming will find instances of

the search word that end in “ing,” “ed,” “x,” “ion,” and so on.

Note: An exception is the ending “er.” Words ending in “er” are excluded from the search

results.

For example, searching for any form of execut will find

• execute, executes

• executed

• executing

• executable, executables

• execution

6. Click Search.

The search pane displays a list of the results.
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7. Click an item from the results list to display the PDF page. Continue clicking items in the results

list, or click Find Next or Find Previous to see the next occurrence.
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